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Introduction

Dakota™ is a PCI soundcard that integrates many
digital audio, MIDI, and synchronization features:

• Two optical ports for digital audio input
(16 channels, ADAT optical format)

• Two optical ports for digital audio output
(16 channels, ADAT optical format)

• One 8-pin port with a breakout cable for
2 MIDI inputs and 2 MIDI outputs

• One 15-pin port with a breakout cable for ADAT 9-pin
sync input and SPDIF digital audio (2-channel input
and 2-channel output on RCA connectors)

• Frontier Design Group’s innovative SoDA™ technology
(SMPTE on Digital Audio) allows any audio input or
output to transmit SMPTE timecode without using
dedicated SMPTE I/O ports

Any optical port can be switched from multichannel ADAT optical format
to stereo SPDIF format for connectivity with DAT machines, MiniDisc
recorders, or any other TOSLINK-compatible equipment.

Dakota also includes a cable that lets you transfer digital audio directly
from a CD-ROM drive, provided that the drive has a compatible 2-pin
digital audio output.

Dakota supports 44.1 and 48 kHz sample rates, and dynamically
resamples 8, 11.025, 16, 22.05 and 32 kHz digital audio for playback
through high-quality external converters. Dakota can also varispeed
and lock to digital audio inputs from 39–51 kHz.

Dakota provides software controls for digital audio input status, sample
rate, sync source, and timecode format, source and destination. It is
also bundled with Cool Edit Pro SE, a multichannel recording and
editing application from Syntrillium Software.
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Dakota supports sample-accurate audio transfers when used with
applications that also support sample accuracy, such as Syntrillium’s
Cool Edit Pro and Steinberg’s Cubase VST.

Dakota’s ASIO driver provides ultra-low latency when adjusting
parameters and monitoring inputs with applications such as
Cubase VST.

Installing Frontier Design Group’s Montana™ card along with Dakota
expands your system to 32 audio inputs and 32 audio outputs on
ADAT optical ports, and adds ADAT 9-pin sync output and an RCA jack
for video sync or word clock input.

The ADAT optical ports on Dakota and Montana can be connected to
any device that also has ADAT optical ports, including digital mixers,
ADAT-compatible tape machines, digital format translators (such as the
Apogee FC-8 for TDIF/ADAT translations), and external A/D & D/A
converters such as Frontier Design Group’s Tango24™ and Zulu™.

Dakota’s MIDI capabilities can also be expanded to 8 MIDI inputs and 8
MIDI outputs by connecting its 8-pin port to Frontier Design Group’s
Sierra™ box, which also has dedicated jacks for SMPTE timecode I/O.

In addition to this User’s Guide, your Dakota package should contain:
• Dakota PCI circuit board

• Breakout cable for 2 MIDI inputs and 2 MIDI outputs (four standard
MIDI 5-pin jacks); connects to Dakota’s 8-pin circular connector

• Breakout cable for ADAT 9-pin sync and SPDIF input and output
(a 9-pin jack and two RCA jacks); connects to Dakota’s 15-pin
D-sub connector

• Internal cable for CD-ROM digital audio

• Envelope containing Dakota software on a 3.5" floppy disk
(please read the envelope before opening it)

• CD-ROM with Cool Edit Pro SE recording/editing software and demo
versions of industry-leading audio production software
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About the Company
Frontier Design Group develops, manufactures and sells digital audio
hardware and software. Our goal is to provide high-quality, high-value
tools to help our customers be more creative and productive.

We’re always interested in receiving your feedback on our products, as
well as your suggestions for improvements and new products.
You can send e-mail to feedback@FrontierDesign.com or send a
fax to 603-448-6398.

Technical Support
If you have any problems or questions that aren’t addressed in this
Guide, there are three ways to get more help:

• Refer to our web site (http://www.FrontierDesign.com) for
information on current revisions, answers to frequently asked
questions, troubleshooting procedures, and additional documentation.
The web site is available every day, 24 hours a day.

• Send specific questions via e-mail to support@FrontierDesign.com.
We do our best to respond promptly (usually within one business day).

• For time-critical questions, you can call Frontier Design Group at
1-800-928-3236 (outside the USA, call 603-448-6283). Phone
support is normally provided weekdays from 9:30 am to 5:30 pm EST.
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Installation

WARNING! The components in your computer and on the
Dakota board are sensitive to electrostatic discharge. Follow these
precautions to avoid damage caused by static electricity —

• Leave the Dakota board in its anti-static wrapping until you’re
properly grounded.

• To become grounded, make sure the computer is off but leave
its power cord plugged in.  Remove the cover, and touch the
computer’s metal chassis.

• Only handle the Dakota board by its edges and metal bracket.

Installing Dakota
Dakota requires one PCI slot in your computer.  If you’re planning to
install Montana in addition to Dakota, be sure to install Dakota in a slot
that is adjacent to an empty PCI or ISA slot.
1. Remove the protective plugs from Dakota’s four optical ports.

2. Make sure the computer is off (but leave its power cord plugged in),
and then remove its cover.

3. Using a screwdriver, remove the blank metal bracket from an empty
PCI slot in the computer, and verify that the motherboard has no
protruding components that would obstruct the 15-pin connector near
the bottom of the Dakota bracket.

4. Insert the Dakota board into the empty PCI slot, and secure the Dakota
bracket with a mounting screw.

5. If your computer has a CD-ROM drive with a 2-pin digital audio output,
you can connect it internally to the Dakota board using the CD-ROM
cable included with Dakota. Push one end of the cable into the CD-
ROM drive’s output connector until it clicks into place.
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6. Route the CD-ROM cable inside the computer to Dakota, and push
the other end of the cable into Dakota’s internal CD-ROM connector
(labelled CD-ROM) until it clicks into place.

Note:  Not all CD-ROM and DVD drives have a 2-pin
digital audio output, and some have the connector but it
isn’t active (such as many Memorex drives).

For a list of compatible drives, you can refer to the
Dakota Frequently-Asked-Questions (FAQ) page on our
web site (http://www.FrontierDesign.com).

7. Replace the cover, and restart your computer.  As it starts up,
Windows detects the presence of the new hardware, and automatically
opens an installation wizard. In Windows 95, it’s the “Update Device
Driver” wizard. In Windows 98, it’s the “Add New Hardware” wizard.

8. Follow the instructions in the wizard, letting Windows search for the
best driver for your device. You’ll need to insert the Dakota Software
disk into the floppy drive and click the “Next” button as the wizard
leads you through the driver installation process.

9. When the wizard indicates that the Dakota Audio Device is installed,
click the “Finish” button.

10. After the installation is finished, remove the floppy disk and keep it in
a safe place in case you ever need to re-install Dakota.

Note: Dakota ships with its MIDI ports disabled (to avoid
a Windows 95 bug that crashes the system if more than
11 MIDI ports are active). For details on enabling Dakota’s
MIDI ports, please refer to the ‘System Tab’ section of the
Software Reference chapter later in this Guide.

Your Dakota shipped with the most recent software available at the
time. The latest version of Dakota software is always available on our
web site (http://www.FrontierDesign.com), and you can download it for
free.
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Installing Cool Edit Pro SE
Dakota comes with a copy of Cool Edit Pro SE, a multichannel recording
and editing application created by Syntrillium Software.
Cool Edit Pro SE is easy to learn and fun to use.

To install Cool Edit Pro SE:
1. Insert Dakota’s CD-ROM into your computer’s CD-ROM drive. Your

browser will automatically open the Dakota Software Sampler home
page from the CD-ROM.

(If your browser doesn’t automatically open the CD-ROM, you can
open it manually by navigating to the “\Frontier\Default.htm” file
on the CD-ROM and double-clicking on it.)

2. When the home page appears, follow its instructions to install
Cool Edit Pro SE and the demo versions of other software.

3. After the installation is finished, remove the CD-ROM and keep it in a
safe place in case you ever need to re-install Cool Edit Pro SE.

This application is a limited version of Cool Edit Pro. The SE version
supports only 10 (mono or stereo) tracks of audio and has no DSP
effects. The CD-ROM includes details about how to upgrade your SE
version to Cool Edit Pro, complete with 64 audio tracks and more than
30 high-quality DSP effects.
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Uninstalling Dakota
To uninstall Dakota, you need to remove the driver and control panel
software, and remove the Dakota hardware.

— Removing the software —

1. Open the Windows Control Panel (StartgSettingsgControl Panel),
and double-click the System icon.

2. When the System window appears, select the “Device Manager” tab.

3. Click the ‘+’ next to “Sound, video, and game controllers” to open
that part of the device tree.

4. Select “Dakota Wave and MIDI Driver,” and click ‘Remove.’

5. When prompted to “Confirm Device Removal,” click ‘OK’ to remove the
driver software.

6. To remove the control panel software, open the Windows\System
folder and delete the “DakPanel.cpl” file.

— Removing the hardware —
1. Make sure the computer is off (but leave its power cord plugged in),

and then remove its cover.

2. Disconnect the internal CD-ROM cable from the Dakota board.

3. Remove the mounting screw that holds the Dakota bracket in the
computer.

4. Lift the Dakota board straight out of its PCI slot.

5. Insert the plastic protective plugs into the four optical ports, and put
the Dakota board into an antistatic bag.

6. Replace the blank metal bracket and the computer’s cover, and restart
your computer.
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Dakota Connectors

MIDI

OU
T B

OU
T A

IN
 A

IN
 B

SYNC+SPDIF

optical inputs

optical outputs

8-pin connector

15-pin connector

for digital audio inputs A1–A8

for digital audio inputs B1–B8

for digital audio outputs A1–A8

for digital audio outputs B1–B8

for 2-in/2-out MIDI breakout cable
(or connection to Sierra box for
8-in/8-out MIDI plus SMPTE I/O)

for ADAT 9-pin sync input
and SPDIF I/O breakout cable



Dakota User’s Guide           9

Connecting Dakota to Other Devices
Dakota has several types of connectors on it. Here are some
suggestions for using them.

— Optical ports and cables —

Dakota ships with plastic plugs covering its optical input and output
connectors. Before installing Dakota in your computer, you can remove
the plugs by pulling them out of the connectors.

The optical ports accept standard TOSLINK™ optical cables. You can
purchase optical cables in lengths up to 10 meters (33 feet) from
Frontier Design Group. Many optical cables have small flexible plastic
covers on their tips to prevent scratches. Make sure you remove the
plastic covers before connecting the cable to an optical port.

The optical connectors are flat on one edge and rounded on the other,
so if the cable doesn’t easily snap into the port, rotate the end of the
cable 180° and try again.

You can connect either end of an optical cable to any optical port, as
long as you’re connecting an output to an input. The direction of an
optical signal is easy to verify because optical outputs emit red light.
The light itself is not dangerous, since TOSLINK and ADAT optical ports
use light-emitting diodes (LEDs) rather than laser light.

Dakota’s optical ports can be used in either 8-channel or 2-channel
mode.

• The 8-channel ADAT mode lets you connect Dakota to multitrack tape
machines, digital mixers, multichannel external A/D and D/A converter
boxes such as Tango24 and Zulu (also from Frontier Design Group),
and other devices that use 8-channel ADAT optical I/O.

• The 2-channel SPDIF mode lets you connect Dakota to DAT machines,
CD players, MiniDisc recorders and other devices that use 2-channel
SPDIF optical I/O.  See the “Software Reference” chapter later in this
Guide for more details.
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— 8-pin port and cables —

Dakota’s 8-pin port is for MIDI I/O. It can be connected either to the
MIDI breakout cable that’s included with Dakota, or to a Sierra (Frontier
Design Group’s multiport MIDI and SMPTE I/O box).

Connecting the 8-pin port to Dakota’s MIDI breakout cable gives you
2 MIDI inputs and 2 MIDI outputs on standard 5-pin MIDI jacks.  Since
MIDI inputs and outputs look the same, make sure you check the labels
and connect your MIDI cables to the appropriate jacks.

If you want to use Sierra (for 8 MIDI inputs, 8 MIDI outputs, and SMPTE
I/O), connect Dakota’s 8-pin port to the cable that’s included with
Sierra instead of connecting Dakota’s MIDI breakout cable, and make
sure you enable Sierra in the Dakota control panel’s System tab. See
the “Software Reference” chapter later in this Guide for more details.

— 15-pin port and cable —

Dakota includes a breakout cable that connects to its 15-pin port.
When you attach the cable to Dakota, make sure you tighten the jack
screws on each side of the connector.

The breakout cable has a DB-9 connector for ADAT 9-pin sync input,
and two RCA (phono) jacks for SPDIF coaxial I/O. Since the input and
output jacks are the same size and shape, make sure you check the
labels and connect your RCA cables to the appropriate jacks.

WARNING!  Do not plug your video monitor into Dakota’s
15-pin port. Although a monitor cable can physically fit into
the connector, it is not intended for that purpose.
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• ADAT 9-pin sync

Dakota’s ADAT sync input can be connected to any device with an
ADAT sync output. To insure proper data transmission, use only cables
that are made for ADAT sync connections.

ADAT sync connections transmit audio clock (sample rate), timecode,
and machine control commands down a sync “chain,” and responses
to the commands run up the chain. The chain runs from the sync
output of the first device (the master) to the sync input of the next
device (slave 1), and from the sync output of slave 1 to the sync input
of slave 2, and so on.

For details about sample-accurate transfers, see ‘Dakota Sync
Features’ in the “Synchronization” chapter later in this Guide.

• SPDIF cables

Standard audio cables have twisted-pair wire rather than coaxial cable,
and are not recommended for use with SPDIF (Sony/Philips Digital
Interface Format) signals.  Although they have the correct connector
on each end, and may work over short distances, they are not reliable
for SPDIF data streams. The reason is related to the differences
between audio and SPDIF signals — audio signals contain frequencies
in the tens of kiloHertz, but SPDIF signals contain frequencies in the
tens of megaHertz, much like a video signal.

slave 1master
out in out in slave 2 out in last slave…

For reliable SPDIF connections, especially over distances longer
than a meter, you should use 75-ohm coax video cables.

Note: If you’ve installed Dakota but not Montana, make sure
the computer is the last slave device in your ADAT sync chain.
If you’ve installed both Dakota and Montana, the computer
can be in any slave position in the chain.
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Tutorial
This tutorial uses Cool Edit Pro SE to demonstrate some of Dakota’s
features. During installation, you probably created a Cool Edit Pro
program group. If so, you can open the application from the Start
menu (StartgProgramsgCool Edit ProgCool Edit Pro Special Edition).

If you haven’t used Cool Edit Pro before, please become familiar with it
first. To learn from its online documentation, select ‘Overview…’ from
the Help menu, click the ‘Contents’ button and open a topic such as
‘Getting Started’ or ‘Navigating Cool Edit Pro.’

Preparing for Playback
This tutorial assumes you’re using a Frontier Design Group Tango24 as
a D/A converter for Dakota, but any external converter can be used
instead. If you don’t have a Tango24, see “Using External Devices for
Playback” later in this section for other setup suggestions.

1. Connect an optical cable from Dakota’s “OUT A” port to the Tango24
optical input.

2. Set the Tango24 clock switch (on the front panel) to ‘Optical’ so the
Tango24 will be slaved to Dakota’s optical output.

3. Make sure the Tango24 analog outputs are properly connected to
your monitoring system.
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to analog inputs
of mixer

analog outs

ADAT out ADAT in
computer with
dakota tango24

4. To open Dakota’s control panel from the Start
menu, navigate to SettingsgControl Panel, and
double-click on the “Dakota” icon.

5. In the Dakota control panel, make sure the Clock
Source is set to ‘Internal’ (so Dakota is the sample
clock master) and set the Sample Rate to ‘44.1kHz.’

Playing a Sound
1. Open Cool Edit Pro SE (CEP) and make sure you’re in

the ‘Edit Waveform’ view.  (F12 toggles between the
‘Edit Waveform’ and ‘Multitrack’ views.)

2. Go to OptionsgSettings… and open the Devices
tab.

3. Set the ‘Waveform Playback’ field to the desired
stereo output (for example, ‘Dakota A 1:2’ to use
Dakota/Tango24 outputs 1 & 2) and click ‘OK.’

4. Open any sound file (.wav file) on your system. If you don’t have a
favorite sound file, you can go to FilegOpen… and navigate to
C:\Windows\Media, where you should find ‘The Microsoft Sound.wav’.
When you double-click on the sound file, its waveform should appear in
the CEP window.

5. Click the Play button (near the bottom left of the
CEP window) to hear the sound. When the sound
is playing, the ‘Clock/Device Status’ tab in Dakota’s control panel
should show bright green status icons for digital outputs A 1:2.
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Using External Devices for Playback

You can use a variety of playback devices to listen to Dakota’s outputs. Here
are some general guidelines for several types of external devices. In all cases,
the best setup for tutorial playback has Dakota as the sample clock master at
44.1kHz, and the external device slaved to its digital input.

• External Converters — Frontier Design Group’s Zulu is always slaved
to its optical input, so you just need to connect Zulu to the correct Dakota
output and set Dakota’s clock source to ‘Internal’ and sample rate to 44.1kHz.
If you’re using a 2-channel external converter, make sure you select SPDIF
(rather than an ADAT pair) as your output (playback) device. Refer to the
“Software Reference” chapter later in this Guide for details on using the optical
ports for 2-channel output.

• ADAT-Compatible MDMs — To use an Alesis, Panasonic or Fostex
multitrack deck as a D/A converter, set it to ‘All Input’ monitoring, ‘Digital’
input, and ‘Dig 44.1kHz’ clock source. On an original (black faceplate) ADAT
machine, enabling ‘Digital In’ automatically sets the clock source to its optical/
digital input.  On an ADAT-XT, use the Clock Select button to choose ‘Dig
44.1kHz.’

• DAT Machines — To use a DAT machine as a D/A converter, set its
input source to ‘Digital’ and enable its ‘Record-Pause’ mode to monitor the
digital inputs. Make sure you select SPDIF (rather than an ADAT pair) as your
output (playback) device.

The input monitoring function works better on some DATs than on others. To
enable input monitoring, a DAT may:

– not need to have a tape loaded (ideal)
– need to have a tape loaded, but not need to spin up its head (OK)
– need to have a tape loaded, and need to spin up its head (unfortunate)

The last case is particularly undesirable because the spinning head will
unnecessarily wear both the tape and the head. If you’re considering
purchasing a DAT machine, ask whether it must have a tape loaded and
whether it needs to spin up its head to enable input monitoring.

Note: Unlike Tango24 and Zulu, you cannot simultaneously use both the A/D
and D/A converters in a DAT machine or an ADAT-compatible MDM.  To record
and play back simultaneously, you’ll need to use separate external recording
and playback devices.
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Editing the Sound
1. In the CEP window, go to EditgSelect Entire Wave, and then

EditgCopy.

2. Click at the end of the waveform, and then go to EditgPaste.

3. Go to ViewgMultitrack View, and then FilegNew Session… and make
sure that 44100, Stereo, and 16-bit are selected. Click ‘OK.’

4. Click near the beginning of Track 1 to indicate where you’ll be inserting
the edited waveform.

5. Go to the Insert menu and select the name of your file. Your edited
waveform should appear on Track 1.

6. Go to OptionsgDevice Preferences… and map the CEP Playback
devices to Dakota, as shown here. Click ‘OK.’

7. In the control area at the left of
Track 1, click the grey button
with the blue number on it to
open the ‘Playback Device’ window.

8. Select the desired output device
(‘Dakota A 5:6’, for example) and click
‘OK.’ (This is how you route tracks to
Dakota output channels in CEP.)

9. Click the Play button to playback Track 1.
You should hear the sound play twice.
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Following SMPTE or ADAT Sync
If you have a source of SMPTE timecode or ADAT Sync, you can use it
to control CEP and play the sound.
1. In Dakota’s control panel, set the Clock Source field to ‘SMPTE/MTC’ or

‘ADAT Sync’ to indicate which type of control signal you’re using.

2. If you selected ‘SMPTE/MTC,’ open the Timecode tab and set the
Timecode Source field to your SMPTE input (see “SMPTE I/O” below
for details). Also make sure the frame rate matches the incoming
timecode.

3. In CEP’s Multitrack View, go to OptionsgSMPTE Start Offset… and
select the frame rate that matches the setting in Dakota’s control
panel. (Set an offset only if you aren’t starting at time 0).

4. Go to OptionsgSettings…gDevices, set the MIDI In (Sync/Trigger)
field to ‘Dakota 1’ and click ‘OK.’

5. On the Options menu, select ‘SMPTE Slave enable’ — a check mark
should appear next to that item in the menu.

6. Start the timecode source to play the sound under external control.

7. When you finish, go to OptionsgSMPTE Slave enable again to turn off
timecode control — the check mark should disappear from the menu.

SMPTE I/O

Dakota features Frontier Design Group’s SoDA™ (SMPTE on Digital Audio)
technology — any audio input can be used for receiving SMPTE timecode,
and any audio output can be used for sending SMPTE timecode. Dakota also
provides integrated SMPTE chase-lock and generation.

If you’ve connected Frontier Design Group’s Sierra MIDI/SMPTE box to Dakota,
you can use its dedicated SMPTE I/O jacks to send and receive SMPTE
timecode instead of using SoDA channels.

You can select the SMPTE timecode input in the ‘Timecode’ tab of Dakota’s
control panel.
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Setting Up to Record
You can record additional tracks in your CEP session by transferring
digital audio from an ADAT, DAT or CD player.  Or you can record
live audio through an external A/D converter, or by using the A/D
converters in an ADAT or DAT machine.

This tutorial assumes you’re using a Frontier Design Group Tango24 as
an A/D converter for Dakota, but any external converter can be used
instead.  If you don’t have Tango24, see “Using External Devices for
Recording” later in this section for other setup suggestions.
1. Connect the Tango24 optical output to Dakota’s “IN A”  port.

2. Set the Tango24 clock switches to “Internal 44.1kHz” so Tango24
is the sample clock master.

continuedè

Note: If you only have one digital tape machine, you’ll be able
to record during this part of the tutorial, but without hearing the
sounds recorded previously (because you can’t simultaneously
use the A/D and D/A converters in an ADAT or DAT machine).
To record and play back simultaneously, you’ll need two tape
machines or an external converter such as Tango24 or Zulu.

from analog outputs
of mixer

analog ins

ADAT out ADAT incomputer with
dakota

ADAT in ADAT out
tango24
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3. In the ‘Clock/Device Status’ tab of Dakota’s control
panel, set the Clock Source to ‘Dig In  Opt A’ so the
computer is slaved to the Tango24 optical output.

4. Verify that all three of Dakota’s ‘Opt A’ input
indicators are green (meaning that the signal is
present, it’s the correct format, and Dakota’s clock
is locked to the input).  If any
indicator is red, refer to the
“Software Reference” chapter
later in this Guide.

5. In CEP, use F12 or the View menu to select ‘Edit Waveform’ view.
(We’ll use ‘Edit Waveform’ view to check the input level, and then we’ll
use ‘Multitrack’ view to actually record.)

6. Go to OptionsgSettings…gDevices, set the
‘Waveform Record’ field to the appropriate input
(Dakota A 3:4 to use Tango24/Dakota inputs
3 & 4, for example), and click ‘OK.’

7. Open the View menu and make sure
‘View Level Meters’ is checked.

8. Right-click on the horizontal meters (at the bottom
of the CEP window) and select ‘Start/Stop Meter’ from the pop-up
menu.

9. Connect the instrument or microphone to the appropriate input, and
adjust the input level so it’s hot without clipping.  When the level is set,
select ‘Start/Stop Meter’ again or click the Stop button to turn off
metering.
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Recording a Track
1. Use F12 or the View menu to select ‘Multitrack’ view.

2. Go to OptionsgDevice Preferences… and map the Dakota inputs to
the CEP Recording devices, as shown here. Click ‘OK.’

3. Click the Track 2 grey button with
the red number on it to open the
‘Recording Device’ window.

4. Select the appropriate input device
(Dakota A 3:4, for example), click
‘Stereo’ to indicate that we’ll be
recording both input channels, and click
‘OK.’ (This is how you route inputs to tracks in CEP.)

5. To record-enable Track 2,
click its red ‘r’ button.

6. Click the Record button (near the bottom left of
the CEP window) to begin recording, and play the
tape or perform live. While recording, the input
status icons for Opt A 3:4 in
Dakota’s control panel should
be bright red, and you should
also hear the audio on Track 1.

7. Click the Stop button when you finish recording. In a moment, the new
waveform should appear on Track 2.

8. To disable recording on Track 2, click its red ‘r’ button again.
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Using External Devices for Recording

You can use a variety of devices to record through Dakota’s inputs. Here
are some general guidelines for several types of external devices. In each
case, connect the external device’s digital output to one of Dakota’s audio
inputs. During setup, look at the input status indicators (in the Audio tab of
Dakota’s control panel) to verify that you’re receiving proper digital input.

• External Converters — External A/D converters should be set for
‘Internal 44.1kHz’ operation for this tutorial. If you’re using Frontier Design
Group’s Zulu, leave the Dakota control panel set to ‘Internal 44.1kHz’
and Zulu will automatically lock to Dakota’s sample clock. If you’re using a
2-channel external converter, make sure you select SPDIF (‘S 1:2’ rather
than an ADAT pair) as the input device.

• CD-ROMs — Some CD-ROM drives have a 2-pin digital audio output.
If you connected such a drive in your Dakota installation, you can select it
as the ‘S 1:2’ input in Dakota’s control panel. Some CD-ROM drives only
have active output if an audio CD is loaded and playing in the drive, so
make sure a CD is actually counting playback time before checking the
input status indicators in Dakota’s control panel. To use Cool Edit Pro’s CD
transport controls, go to ViewgShow CD Player.

• ADAT-Compatible MDMs — To use an Alesis, Panasonic or
Fostex multitrack deck as an A/D converter, set it to ‘All Input’ monitoring,
‘Analog’ input, and ‘Int 44.1kHz’ clock source.  An original (black faceplate)
ADAT machine automatically switches to internal sync when its ‘Digital In’
button is off. If you’re using a BRC or an original ADAT machine, you set
the clock to 44.1kHz by pitching down to -147 cents.

• DAT Machines — To use a DAT machine as an A/D converter, set
its input source to ‘Analog’ and enable its ‘Record-Pause’ mode to monitor
the analog inputs. Make sure you select SPDIF (rather than an ADAT pair)
as your input (recording) device.

The input monitoring function works better on some DATs than on others.
For details, see ‘DAT Machines’ in the section “Using External Devices for
Playback” earlier in this tutorial.

Note: Unlike Tango24 and Zulu, you cannot simultaneously use both the A/
D and D/A converters in a DAT machine or an ADAT-compatible MDM. To
record and play back simultaneously, you’ll need to use separate external
recording and playback devices.
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   Software Reference
To open Dakota’s control panel from the Start menu, navigate to
SettingsgControl Panel, and double-click on the “Dakota” icon.

Dakota’s control panel includes four tabs — Clock/Device Status,
Timecode, Patchbay, and System. Each tab contains several sections,
each with one or more fields.

Whenever Dakota is installed in your system, an icon
with two bars appears in the Windows Taskbar. The
top bar lights red whenever any Dakota input is active,
and blinks whenever an active input has an error (see the
Clock/Device Status tab for details about any input error). The
bottom bar lights green whenever any Dakota output is active.

Double-clicking on the icon opens the Clock/Device Status tab. You can
also right-click on the icon to display a menu that lets you go directly
to the Clock/Status, Timecode, Patchbay, or System tab.

Clock/Device Status Tab
The Clock/Device Status tab contains five sections — Clock Source,
Sample Rate, Varispeed, Digital Input Status, Digital Output Status.
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— Clock Source —

The audio clock can come from many sources
if you’re using Dakota, and even more sources if
you’re also using Montana.

— Sample Rate —

In this section, a drop-down box lets you select
the expected sample rate (44.1 or 48kHz).  If
the ‘Lock’ box is checked, then applications can
only use that sample rate.  For example, if the
sample rate is locked at 48kHz and you try to play a 44.1kHz sound,
an error message will appear. The Sample Rate section also displays
the actual current sample rate as measured by the computer.

Internal 44.1 or 48kHz, depending on
the Sample Rate selection

ADAT Sync In Dakota can follow word clock from its ADAT Sync In port

SMPTE/MTC In this mode, Dakota sets its sample clock to match the
incoming timecode as selected in the Timecode Source section

Video With a video source connected to Montana, Dakota can derive
a sample clock that is locked to the incoming video signal

Wordclock With a word clock source connected to Montana, Dakota can
set its sample clock to match the incoming word clock signal

Dig In Any digital input can be used to set the sample rate. ‘Opt A’
and ‘Opt B’ are Dakota’s optical inputs. ‘Opt C’ and ‘Opt D’ are
Montana’s optical inputs. ‘SPDIF’ is Dakota’s RCA (coax) input.

Varispeed Lets you use the Varispeed slider to adjust the sample rate
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— Varispeed —

If ‘Varispeed’ is selected in the Clock Source
field, you can manually set the sample rate to
anything between 39 and 51kHz by dragging the Varispeed slider.

— Digital Input Status —

This section displays the audio input status in the form of error
indicators, mappings from physical inputs to logical inputs, and
channel indicators.

On the left are three rectangular error indicators for
each of Dakota’s and Montana’s physical inputs
(Opt A, Opt B, Coax, and so on).

A red indicator represents an error, and green means “good to go.”
A slash across a green indicator means that at least one error was
detected since the errors were last cleared. To remove all slashes, click
on the ‘Clear Errors’ button.

From left to right, the indicators are:

Signal green = input signal active
red = input signal inactive

Format
(Fmt)

green = valid digital audio format detected
red = error in digital audio signal format
(for example, feeding an SPDIF signal to an ADAT input)

Slip green = Dakota is locked to incoming audio clock
red = Dakota’s sample rate is different than the incoming audio clock

If Dakota’s sample rate is almost the same as the incoming audio clock,
but not perfectly locked, the Slip indicator flashes red periodically. A
slash appears across the green indicator until you click ‘Clear Errors.’
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By default, the physical inputs (Opt A, Opt B, Coax, and so on) are
mapped directly to the logical devices (A 1:8, B 1:8, S 1:2, and so on)
that you’ll use within your recording/playback applications.

The stereo device ‘S 1:2’ (in SPDIF format) can come from any
physical input — an optical input, the RCA (coax) input, or the internal
CD-ROM 2-pin connector. You can select the stereo input device from
the drop-down box next to ‘S 1:2.’

The physical-to-logical mapping
lines automatically change to
graphically reflect your selection.

The ‘Channels In Use’ indicators show activity on each input channel. If
an input channel is in use, its indicator is bright red.
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— Digital Output Status —

This section shows which output
channels are active and the
mapping from logical output
devices to physical outputs.

When an output channel is playing data, its indicator is bright green.

The stereo SPDIF stream is always present on Dakota’s coaxial output
(on the breakout cable). You can also route the SPDIF stream to any
or all of the Dakota/Montana optical outputs.

Clicking on the button next to
Opt A, B, C, or D toggles the
corresponding optical output
between 8-channel mode
(ADAT optical) and 2-channel
mode (SPDIF optical).

The logical-to-physical mapping lines automatically change to
graphically reflect your selection.
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Timecode Tab
The settings in this tab control where and how timecode is sent.

— Timecode Source —

The Timecode Source field lets you select the timecode input.
Selecting ‘Internal’ ignores all external timecode sources, and allows
the applications running on your PC to control timecode generation.

Most recording/playback applications can only receive and follow MIDI
Time Code (MTC) since it’s the only form of timecode in the Windows
standard interface.  If you’re using ADAT Sync or SMPTE input, Dakota
automatically converts the timecode to MTC for use by applications.

When ‘ADAT Sync In’ is selected as the timecode source, Dakota
receives timecode information (expressed as a sample count) from the
ADAT Sync In port on Dakota’s 15-pin breakout cable and passes it to
the application in the format specified by the Timecode Format field. In
most cases, when the Timecode Source is set to ‘ADAT Sync In,’ the
Clock Source (on the Clock/Device Status tab) should be set to ‘ADAT
Sync.’
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You can also use Frontier Design Group’s innovative SoDA™
technology to receive SMPTE timecode on any Dakota or Montana
digital audio input —
1. Connect a SMPTE timecode source to an A/D

converter (such as Zulu or Tango24), and connect
the A/D converter to the desired Dakota or
Montana digital audio input.

2. Set the Timecode Source field to ‘SoDA Channel’
and select the appropriate input channel.

To receive MTC from a MIDI input, set the Timecode Source field to
‘MTC Port’ and select the appropriate port number (1 or 2 if you’re
using Dakota’s 2-in, 2-out MIDI cable, or 1–8 if Dakota is connected to
Sierra). See ‘Timecode Destinations’ later in this section for information
about routing the MTC to an application and to MIDI output ports.

To receive SMPTE timecode through Sierra’s ¼" SMPTE input, make
sure Sierra is properly connected to Dakota, and set the Timecode
Source field to ‘Sierra SMPTE In.’

— Timecode Format —

The Format field specifies the form of timecode
(SMPTE or MTC) expected to be received and
generated. The timecode rate, expressed in
frames per second (fps), can be set to:

• 24 – for film applications
• 25 – for PAL or SECAM video rates

• 29.97 ND – NTSC input without drop frame (wallclock ≠ timecode)
• 29.97 DF – standard timecode for NTSC video
• 30 ND – for most music projects and NTSC black/white video
• 30 DF – rare (to “pull down” the sample rate if the

       external timecode source is 29.97fps)
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Sometimes a SMPTE timecode signal has dropouts or noise that
temporarily garble the timecode. Similarly, a MIDI Time Code packet
can be lost. Dakota lets you “freewheel” past
these temporary problems in timecode input.
The Freewheel setting lets you control how long
Dakota continues generating timecode in the
presence of poor or idle input.

The Status line indicates when a timecode input is active, and whether
Dakota is able to lock to it. The current time appears in the Time field.

— Timecode Destinations —

To use SoDA for sending
timecode through a Dakota or
Montana digital audio output,
check the ‘SoDA Channel’ box
and select the desired output.

You can control the output level on the SoDA channel from -19dBFS to
-48dBFS using the Output Level field.

Whenever Dakota is receiving timecode and is properly connected to
Sierra, the timecode is automatically sent out from Sierra’s SMPTE Out
port. Dakota’s Output Level field lets you set Sierra’s timecode output
level for a +4dBu or -10dBV environment.

Incoming timecode can be sent to an application by merging it on a
MIDI input port. The ‘MIDI In’ check boxes let you select any or all MIDI
input ports. For example, enabling MIDI In 5 allows applications to sync
to Dakota’s timecode reader by selecting ‘Dakota MIDI 5’ as a MIDI
input device. Similarly, the ‘MIDI Out’ check boxes let you send MTC out
any of the physical MIDI output ports in your system.

Note:  If Sierra is not connected to Dakota, only MIDI ports
1 and 2 are active. Ports 3–8 can only be used if Sierra is
properly connected to Dakota.
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— SMPTE Stripe —

You can use Dakota’s timecode generator for striping SMPTE timecode
on an external device. Enter
the desired time (written as
hours:minutes:seconds:frames)
in the ‘Start Time’ field.

When you click the Start button, Dakota’s timecode source
automatically switches to ‘Internal’ and SMPTE timecode is sent to the
appropriate outputs. Click the Stop button when you finish striping the
timecode.

Patchbay Tab
The Patchbay tab lets you route any of Dakota/Montana’s audio inputs
to any of the audio outputs. You can use the Patchbay tab both for
input monitoring and for digital audio format conversions.

Dakota and Montana inputs appear in the top row of icons; outputs
appear in the bottom row. To create a patch, click on an input icon and
then click on an output icon, or drag the cursor from an input to an
output. Lines automatically appear to indicate the routing(s).
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For example, you can monitor Dakota’s “Optical B 3:4” inputs
through the SPDIF coax outputs, as shown here.
To delete a particular routing, double-click on its input or output icon.
To undo all the current routings, click the “Clear patches” button.

To save the current
routings in the
Patch Library, click
“Save…” and type
a name for the
patch. You can then restore those routings by selecting the saved
patch from the drop-down box.

To remove a saved patch from the Library, select the patch in the
drop-down box and then click the “Delete” button.

System Tab
In addition to displaying the Dakota software version and contact
information for Frontier Design Group, the System tab lets you enable
the MIDI ports and set other options.
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Clicking the ‘Frontier Web Site’ button launches access to our web site
if your PC has an internet link and web browser. The System tab also
has a checkbox labelled “Keep Dakota On Top.”
When the box is checked, the control panel
remains in front of other windows on your screen.

— MIDI Mode —

To avoid a Windows 95 limitation (see warning below), Dakota ships
with its MIDI ports disabled. Use the MIDI Mode section to enable the
MIDI ports for Dakota or Sierra.

If you’re using the Sierra 8-in, 8-out MIDI/SMPTE
expansion box with Dakota, select ‘8x8 Sierra.’

If you’re using Dakota’s 2-in, 2-out MIDI breakout
cable instead, select the ‘2x2’ option.

Whenever you change the MIDI Mode setting, you need to reboot the
computer for the change to take effect.

WARNING!  Windows 95 is limited to a maximum of 11
MIDI input ports and 11 MIDI output ports. Adding Dakota’s
(or Sierra’s) MIDI ports may put your system beyond the
limit, causing it to crash with the “blue screen” message
“MSGSRV32 caused a general protection fault…”.

There is no easy way to recover from this crash, so before
enabling MIDI ports in the Dakota control panel, make sure
your Windows 95 system doesn’t have too many other MIDI
ports enabled (9 if you’re using just Dakota; 3 if you’re using
Sierra). This MIDI limitation is not a problem in Windows 98.
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— Output Channel Status —

The Output Channel Status section lets you set the
channel status bits for Dakota’s stereo outputs to either
Consumer (SPDIF) or Pro (AES/EBU). The default is SPDIF.
If you have an external SPDIF-to-AES/EBU converter, you can use
Dakota’s Pro (AES/EBU) setting to generate true AES/EBU output.

— Buffer Size —

The Buffer Size indicates how often data is processed
between the Dakota hardware and its driver. Smaller
buffer sizes yield faster response times (lower latency), which most
noticeably affect audio functions such as monitoring inputs in the
Patchbay or using Dakota’s ASIO driver in Cubase VST. Larger buffer
sizes provide more protection against audio glitches. The default
setting is 256 samples. We recommend that you set the buffer size as
large as possible while attaining suitable latency for your audio.

— ASIO Resolution —

You can set the resolution for recording and playback
to ‘16 bit’ or ‘24 bit’ when using Dakota’s ASIO driver
in applications such as Cubase VST. You may also need to set the
resolution in the application itself. For example, to record and play 24-
bit audio in Cubase VST, you have to enable its ‘24-bit’ button.

Note:  You must close all audio applications before you
change Dakota’s buffer size. The new setting takes effect
when you restart the application(s).

Note:  You must close all audio applications that use Dakota’s
ASIO driver before you change Dakota’s ASIO resolution. The
new setting takes effect when you restart the application(s).
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ASIO Driver
Dakota’s ASIO driver provides ultra-low latency for real-time audio
functions such as input monitoring and adjusting EQ, pan, and other
parameters.

To use Dakota’s ASIO driver in Cubase VST:
1. Close Cubase VST, and open the System tab of Dakota’s control panel.

2. Select the desired Buffer Size and ASIO Resolution settings (described
on the previous page).

3. Open Cubase VST, and select “System…” from the Audio menu.

4. In the ‘Audio I/O’ section of the Audio System Setup window, set the
‘ASIO Device’ field to “ASIO Dakota Driver.”

5. Verify that the sample rate, audio source, number of channels,
and other options are correct. Using larger disk block buffer sizes in
Cubase VST may improve performance (ie, the number of tracks).

6. Click “OK” to close the Setup window.

Note:  To actually record or play 24-bit audio, you must set
Dakota’s ASIO Resolution to ‘24 Bit’ (in step 2) and you also
need to enable the ‘24-bit’ button in Cubase VST.
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   Synchronization
Whenever you transfer digital audio from one device to another, the
devices must be properly synchronized. There are two types of
synchronization, and each can be transmitted by a variety of signals.

• Sample rate synchronization is required in every digital audio system
to guarantee that all devices in the system are recording and/or
playing audio at exactly the same rate.

• Timecode synchronization is not always required, but allows two or
more devices to reference the same position in time. Timecode
facilitates synchronizing a computer with another recorder or
sequencer, so that (for example) you can press Play and have all your
equipment begin playback exactly three bars into the second chorus.

Sample rate sync
Every digital audio system operates at a particular sample rate,
such as 44,100 samples per second (44.1kHz) for CDs. The sample
rate can be explicitly transmitted between devices (using BNC word
clock, for example) or it can be embedded in a digital audio stream
that uses a self-clocking format (ADAT optical, SPDIF, or AES/EBU).
The sample rate can also be derived from NTSC or PAL video signals.

When two or more digital audio devices transfer data, one and only one
of them should be used to set the sample rate. This device can have a
variety of names — system clock source, sync source, sample clock
master, audio clock master, or word clock source.  The master device
uses an internal oscillator to set the sample rate.  All other devices
must be synchronized (slaved) to the sample clock master, so their
digital clocks are locked to the master clock.

No two oscillators run at exactly the same rate, even if they’re both
44.1kHz oscillators (for example). Therefore, if two devices in a system
are set to internal sync, each using its own internal oscillator, one is
inevitably a bit faster than the other.  As a result, samples are lost or
duplicated during the transfer, corrupting the audio.
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When one device (the slave) gets its sample rate from another device
(the master), we say that the slave device is locked  to the master.  In
contrast, when two devices are operating at independent sample rates,
they are slipping  relative to each other.  When multiple sample rates
are detected, some devices mute, some generate clicks and pops, and
some exhibit completely erratic behavior.

Dakota and Montana both use Dakota’s clock system (and Sierra
doesn’t need a sample clock), so you can think of them as a single
device for sample rate purposes.  Tango24 and Zulu, however, are
separate devices and must be properly synchronized when connected
to either Dakota or Montana.

For example, to use Zulu with Dakota (alone or with Montana), set
Dakota’s Clock Source to ‘Internal 44.1 or 48kHz’ so that Zulu is
slaved to Dakota.

When using one or more Tango24 converters with Dakota (alone or
with Montana), there are many sync options:

• To use a Tango24 as the master, set its clock switches to ‘Internal
44.1 or 48kHz.’  Set all other Tango24 units to ‘Word Clock’ (coming
from the master Tango), and set Dakota’s Clock Source to a digital
input that’s connected to one of the Tango24 units (Opt A, for
example).

• To use Dakota as the master, set its Clock Source to ‘Internal 44.1 or
48kHz,’ and set all the Tango24 clock switches to ‘Optical.’

• To use an external device as the master (generating ADAT Sync,
SMPTE timecode, word clock, or video sync), set Dakota’s Clock
Source to the corresponding input, and set all the Tango24 clock
switches to ‘Optical.’

REMEMBER!  Any digital audio system must always have
exactly one sample clock master, which should determine the
sample rate for all devices in that system.  If the sample rates
don’t match, you’ll hear glitches, dropouts, or nothing at all.
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Timecode sync
Timecode sync enables two or more devices to start at the same
position and remain in sync as you record and play back. Timecode
sync is useful if you want to record audio from one device to another
for editing, and then transfer the edited audio back to the same
position on the original device.  It’s also useful if you want to record on
two separate devices simultaneously and then mix down from both.

Timecode information is transmitted in SMPTE, MTC (MIDI Time Code)
and ADAT sync formats. See “Timecode Signals” later in this section for
details about each format.

Timecode sync is not needed for hard-disk recording on only a single
computer (for example, if you’re recording multichannel audio through
a Tango24 converter box connected to Dakota or Montana). Timecode
sync is also not needed if you want to record digital audio from one
device to another without transferring it back to the same position on
the original device (for example, if you’re recording from an ADAT tape
machine to the computer, and then mixing to DAT).

As stated in the previous section, audio clock sources specify only a
rate (samples per second).  Timecode sources specify both a rate (in
frames per second or fps) and a position (in hours, minutes, seconds,
and frames).  Here are the four standard frame rates, and their
common uses:

• 24 fps – Film worldwide

• 25 fps – PAL/SECAM video in Europe

• 29.97 fps – NTSC color video in North America and Japan

• 30 fps – NTSC black/white video, and most music-only projects
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Usually, the audio clock master and timecode source are the same
device.  When timecode is sent from the master device, the slave
devices chase (or follow) the timecode so all devices are locked to the
same position and operate at the same sample rate.

Sometimes, however, you may want to use an audio clock source that
is different than the timecode source. In such situations, the clock and
timecode sources must  be referenced to a common timebase, as
shown in the following example.

The sample rate (audio clock) in the ADAT optical signal and the frame
rate (timecode) in the SMPTE signal must be locked together.
Otherwise, the digital audio system doesn’t know which rate to follow.

A classic problem occurs when “wild” SMPTE timecode is recorded on
a digital tape machine. “Wild” means that the SMPTE generator was
not locked to the digital tape machine’s sample rate while recording
the timecode and audio.

When the audio is digitally transferred to the computer using SMPTE
timecode sync, the computer sees two different rates. Some audio
applications try to adjust the audio to match the SMPTE timecode rate,
but that taxes the computer’s CPU and can introduce audible
distortion.

word clock
computer

external A/D
converter

sync box
SMPTE timecode

ADAT
optical

audio in

computerdigital tape machine
SMPTE timecode

ADAT optical
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Dakota sync features
In an integrated audio/sync system such as Dakota, the sample rate can
be locked to a timecode input. If a 30fps SMPTE timecode signal is the
source for a 44.1kHz sample rate, Dakota can lock  the audio clock to
the timecode source by ensuring that there are 44100 audio samples
for every incoming 30 timecode frames — particularly useful when
locking to a video deck with SMPTE output, or when recording tracks
from analog tape that has SMPTE timecode recorded on it.

Systems without integrated audio/sync functions try to manipulate the
audio data to obtain the correct sample rate. Some add or remove
samples; others perform crude sample rate conversions. However, these
techniques tend to distort the resulting audio, slowing down the
computer. Dakota’s hardware-based chase-lock capabilities eliminate
those sources of audio distortion, and free the CPU for other tasks.

— Sample-accurate sync —
Dakota supports sample-accurate transfers between the computer and
an ADAT machine, as shown in this example using Cool Edit Pro.
1. Connect the ADAT’s 9-pin sync output to Dakota’s ADAT 9-pin sync

input, and set Dakota’s control panel options to:

2. Open a new 48kHz project in Cool Edit Pro, and select multitrack mode.

3. In the Options menu, enable ‘Sample Accurate Sync’ and
(under SettingsgDevices) set MIDI IN to ‘Dakota 1.’

4. Arm track 1 in Cool Edit Pro, and press F7 to enable SMPTE Sync mode.

5. Play the ADAT. Cool Edit Pro automatically starts recording
(and displays waveforms) when it receives timecode.

6. Press F7 again to disable SMPTE Sync mode. Recording stops, and the
waveforms are redrawn in their sample-accurate positions on the
timeline.

Clock source = ADAT sync
Sample rate = 48 kHz

Timecode source = ADAT sync
Frame rate = 30 ND

Also, enable checkbox 1 after
‘MIDI In devices (to software)’
so Dakota port 1 will send
ADAT-derived MTC to Cool Edit.
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— SMPTE timecode —
Using Dakota’s unique SoDA™ technology (SMPTE on Digital Audio),
Dakota and Montana can receive SMPTE timecode on any audio input,
and transmit SMPTE timecode on any audio output.  See ‘Timecode
Source’ in the “Software Reference” chapter for detailed instructions.

The Dakota control panel lets you set the SMPTE output level and
specify which ports are used for SMPTE timecode. See the “Software
Reference” chapter earlier in this Guide for more details.

Setting the correct SMPTE level used to be difficult on old analog tape
decks. If the level was too low, the signal would be lost in the noise. If
the level was too high, the signal would bleed onto neighboring audio
tracks. Cross-track bleeding is greatly reduced in modern digital
systems, so Dakota’s default SMPTE level works quite well.

Timecode Signals

SMPTE – Audio engineers commonly use the term “SMPTE” when referring
to Linear Time Code (LTC) as defined by the Society of Motion Picture and
Television Engineers (SMPTE).  A SMPTE signal is a series of alternating tones
which can be transmitted and recorded just like any other audio signal. It
encodes time as a series of frames, each containing 80 bits of data including
frame boundaries, the time (expressed in hours, minutes, seconds, frames),
as well as several user-definable bits. The timecode portion is displayed as
a four-part number such as 10:37:09:12, meaning 10 hours, 37 minutes,
9 seconds, and 12 frames.

MTC – The Musical Instrument Digital Interface (MIDI) specification includes
a method of transmitting and receiving timecode using MIDI messages. MIDI
Time Code (MTC) is also based on frames. One MTC message is transmitted
for every quarter frame of timecode, so the resolution of MTC at 30fps is fixed
at 8.33 msec (1/30 x 1/4 = 0.00833).

ADAT Sync – Some ADAT-compatible devices, including Dakota and
Montana, have 9-pin connectors for transmitting and receiving ADAT Sync
signals. An ADAT Sync signal includes both rate (word clock) and timecode
information, but the timecode is not frame-based. Instead, it identifies the
timecode position to the resolution of the audio samples themselves,
providing the capability of sample-accurate transfers — about 400 times the
accuracy of SMPTE timecode or MTC.
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Tuning the System

Because Windows 95 and Windows 98 are general purpose operating
systems, some of the default system settings may not be optimal for
digital audio work. This chapter offers suggestions that may help
improve the performance of your system.

Please check your audio application’s documentation for additional
performance tips. If you have Internet access, you may want to
periodically check your software manufacturer’s web site in addition to
ours (http://www.FrontierDesign.com) for updated information.

Disk Drives
Whenever possible, use a large, fast, separate disk for storing your
digital audio. Digital audio consumes a lot of disk space. For example,
5 minutes of an 8-channel, 44.1kHz, 16-bit recording consumes about
212 MB on your hard disk. With disk prices decreasing all the time,
large disks are quite affordable. Nevertheless, you need to be sure
your disk has enough room for your projects. You may need to archive
older projects to tape or removable disks.

The number of tracks that your software will be able to transfer in real
time depends on the speed of your hard disk subsystem (and your
CPU, of course). The EIDE disk subsystem that comes with many
desktop systems should be fine in most cases but for the best
performance, consider a PCI-based Wide UltraSCSI adapter and “AV”
(audio-visual) rated disk drives with at least 7200rpm spindle rates.

Use a separate disk drive for your audio. By keeping your programs,
virtual memory swapfile, and any disk caches on a different drive, you
keep the disk activity associated with those operations separate from
the continuous reading and writing of audio data. This should result in
less head movement and higher overall throughput for your audio.
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Thermal Recalibration
Don’t use disk drives that interrupt data flow for “thermal
recalibration,” a compensation for mechanical changes that
occur as the drive warms up and cools down.

We believe that most new drive designs (even non-AV rated drives)
don’t need thermal recalibration, but if you have an older drive and are
experiencing audio dropouts under heavy loads (lots of tracks), you
may want to ask the drive manufacturer whether thermal recalibration
is performed on that type of drive.

Data Compression
Don’t use data compression on the drive that stores your digital audio.
Although Windows 95/98 supports data compression  (for example,
the DriveSpace utility that comes with Microsoft’s “Plus!” add-ons for
Windows 95), the compression algorithms generally don’t work well
with digital audio. Furthermore, because the CPU spends time
compressing and uncompressing your files, fewer CPU cycles are
available for mixing tracks in your audio application.

Disk Fragmentation
We recommend that you defragment your disk regularly, especially
after heavy editing sessions. Defragmenting reorganizes files into
contiguous areas on the disk, so that the entire file can be accessed
with a minimum number of head movements.  One strategy is to leave
the PC running and defragment the disk at the end of each day.

Sporadic Disk Activity
Avoid applications and utilities that cause sporadic disk activity. Some
applications think they’re doing you a big favor by hanging around in
the background until the last crucial 10 seconds of your mix-down,
when they awaken and start pounding your disk.
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Here’s a list of some applications and utilities that cause sporadic disk
activity, and suggestions for thwarting them.

— System Agent —

System Agent (included in the Microsoft Windows add-on) includes
utilities that scan your disk for errors and perform disk
defragmentation. System Agent allows you to schedule these activities
so they occur at specific times or when you haven’t used your
computer for a period of time. To prevent these disk-intensive activities
from occurring, we recommend that you either disable System Agent
while doing your audio work (right-click its icon in the system tray of
the Task Bar), or schedule the activities to occur when you’re
absolutely sure that you won’t be trying to record and play audio.

— Find Fast for Office —

If you use Microsoft’s Office products (Word, Excel, PowerPoint,
Schedule, or Access), the “Find Fast” utility was probably installed in
the Windows Control Panel. The utility periodically scans your disks,
building indices of all your Office documents so their names can be
displayed quickly. Unfortunately, the indexing activity could pound your
disks while you’re trying to play back a multitrack recording.

To prevent Find Fast from running, you can either remove it
permanently or disable it temporarily while you work on audio.

• To disable Find Fast permanently, open the Windows “Startup” folder
and delete “Microsoft Office Find Fast Indexer.” (You can use Windows
Explorer to navigate to “C:\Windows\Start Menu\Programs\StartUp.”)

• To disable Find Fast temporarily, open the Windows Control Panel
(StartgSettingsgControl Panel) and double-click the Find Fast icon.
When the Find Fast window appears, select ‘Pause Indexing’ from the
Index menu. When you want to enable Find Fast, select ‘Pause
Indexing’ again.
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— Screen Savers —

Few things are worse than having your audio interrupted by the
sudden appearance of a bunch of flying toasters (or some other
screen saver). A screen saver is particularly vexing because its delay
timer silently ticks away when you’re not touching your mouse or
keyboard (when you’re printing your final mix to DAT, for example).

To disable the screen saver, consult its documentation, or try this
procedure: open the Windows Control Panel, double-click the Display
icon, select the “Screen Saver” tab, and click the down arrow next to
the “Screen Saver” box. Select ‘None’ (the first entry) and then click
‘OK’ to confirm the selection.

— CD-ROM “Auto-Insert” Notification —

When this option is enabled, Windows may periodically poll your
CD-ROM drive to see if you’ve changed CD’s, causing the CD-ROM
access light to blink about every five seconds. If Windows Explorer is
open and detects a new CD, you’ll experience a flurry of disk and CPU
activity while the folder and filenames of the new CD are updated in the
display. The CPU activity may cause dropouts in your audio.

If you don’t load a CD during audio operations, you may not experience
this problem, but it’s a nice opportunity to rid your machine of that
annoying flashing LED!
1. Open the Windows Control Panel (StartgSettingsgControl Panel),

and double-click the System icon.

2. When the “System Properties” dialog box appears, click the “Device
Manager” tab and then click ‘+’ to open the “CD-ROM” sub-tree. A list
of installed CD-ROM drives appears (there may be only one in the list).

3. Double-click the line that describes your particular model of CD-ROM
(“NEC CDR-74”  for example).

4. When the “Properties” dialog box appears, click the “Settings” tab
and uncheck ‘Auto insert notification.’

5. Click ‘OK’ to confirm the change, and then close the Control Panel.
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Multi-tasking
Windows 95/98 can run many applications at once, but if you run more
than one at a time, the performance of each individual application
diminishes. Your audio applications are particularly heavy users of CPU
cycles and disk bandwidth, so it’s important to minimize the use of
other high-demand applications. It’s probably OK to run a word
processor in the background while you’re mixing down, but avoid
applications that do a lot of computation or frequently access the hard
disk.

File Caching
Windows 95/98 has built-in file caching which saves your most recently
accessed data in memory. Since file caching is of limited use in digital
audio applications, you may want to restrict the amount of memory
reserved for file caching. Locate the SYSTEM.INI file in your Windows
folder, and open the file in a text editor such as Notepad. Create (or
find and edit) a section named “[VCache]” and make sure the
MinFileCache and MaxFileCache are both set to:

4096 (for a computer with 32MB of RAM), -or-
8192 (for a computer with 64MB or more of RAM)

The values are given in kilobytes (KB) of RAM (2048 means 2MB of RAM).

WARNING! Do not use values for MinFileCache or
MaxFileCache that begin to approach the amount of physical
RAM in your machine. NEVER use values greater than the old
Windows 3.1 limit of 24576 (24 MB).  Microsoft specifically
warns that it does not guarantee performance of the cache at
sizes larger than this and disavows responsibility for data
corruption or loss that may occur. So do we!



Dakota User’s Guide           45

Other Caching Options
There are several other caching options which may affect your PC’s
audio performance —

• You may want to limit the amount of “Read-ahead optimization”
performed by Windows. Open the Control Panel (StartgSettingsg
Control Panel), and double-click the System icon. Select the
“Performance” tab, and click the ‘File System...’ button. When the “File
System Properties” dialog appears, select the “Hard Disk” tab, and
move the ‘Read-ahead optimization’ slider all the way to the left.

• In the same dialog (“File System Properties”), you can specify the
“Typical role of this machine.” In most cases, you’ll want it set to
‘Desktop computer.’

• You may want to disable “write-behind caching.” In the “File System
Properties” dialog, select the “Troubleshooting” tab and check the
box labelled ‘Disable write-behind caching for all drives.’



Dakota User’s Guide           46

Virtual Memory Swapfile
When the demands of multi-tasking exceed the limits of physical
memory on your machine, Windows dynamically changes the size
of the swapfile that it uses to hold code and data. You can improve
audio performance by setting the swapfile parameters manually.

Open the Control Panel, double-click the System icon, select the
“Performance” tab in the System Properties dialog, and click the
“Virtual Memory…” button. When the “Virtual Memory” dialog
appears, select “Let me specify my own virtual memory settings.”

Set the following parameters in the dialog:

Hard disk: choose a disk other than the one you use for digital audio
(if possible)

Minimum: set it to 2.0–2.5 times the size of your system memory
Maximum: set it to the same value you specified for minimum

Leave “Disable virtual memory” unchecked!
(Otherwise, Windows displays a warning.)

Click “OK” to confirm your choices, and close the Control Panel. After
changing this setting, you’ll be reminded that the new settings won’t
take effect until you restart Windows.



Dakota User’s Guide           47

Graphics Acceleration
If you experience glitches during recording or playback, you may have
a video driver problem. If so, try reducing the amount of graphics
acceleration used by Windows. Open the Control Panel, double-click
the System icon, select the “Performance” tab in the System
Properties dialog, and click the “Graphics…”  button. When the
“Advanced Graphics Settings” dialog appears, move the “Hardware
acceleration” slider all the way to the left. Click “OK” to confirm the
setting, and close the Control Panel. After changing this setting, you’ll
be reminded that the new settings won’t take effect until you restart
Windows.

After you’ve rebooted, see if the glitching problem is gone. If so, you
may want to experiment with other settings of the “Hardware
acceleration” slider to regain some of the graphics performance.

32-bit Drivers
To obtain the best possible performance from your disk system, use
32-bit drivers. Generally, the Windows installation replaces real-mode
drivers with 32-bit protected mode drivers. However, there may not
have been any 32-bit drivers that were compatible with your hardware
when Windows was released. To check the driver, open the Control
Panel, double-click the System icon and select the “Performance” tab.
If the “File System” status doesn’t indicate “32-bit,” contact the
manufacturer of your disk controller to get a 32-bit protected mode
driver and install it in your system.
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Windows System Monitor
Windows includes a “System Monitor” utility that displays important
performance information about your machine. If it’s installed, you can
usually find it by following this path in the Start menu:

StartgProgramsgAccessoriesgSystem ToolsgSystem Monitor

When Dakota’s driver is loaded, it notifies Windows that it can collect
statistics that indicate how well the system is responding to Dakota’s
requests to read and write audio data.

You can display these statistics and compare them with other
important performance data —
1. Start the System Monitor application (StartgProgramsg

AccessoriesgSystem ToolsgSystem Monitor).

2. Click on the fourth icon in the tool bar (it looks like a funky blue
mountain range) so that data will be displayed in “time-line” format.

3. Select “Add Item…” from the Edit menu.

4. In the “Category” box, click ‘Dakota Performance.’  The list on the
right indicates which Dakota performance data can be displayed.

5. Select one or more items from the list and click ‘OK.’  The graphical
display adds the statistics you selected. You may also want to select
items from other parts of the system so you can correlate Dakota’s
performance with other CPU and disk activity.

The following list describes the available Dakota statistics.

What if you don’t have System Monitor?

System Monitor is optionally installed as part of Windows 95/98, but every
Windows 95/98 PC can load it. Open the “Add/Remove Programs” control panel
(StartgSettingsgControl PanelsgAdd/Remove Programs). In the “Windows
Setup” tab,  scroll down and select “Accessories.” Its check box will be gray if
some of the accessories aren’t installed. Click the ‘Details…’ button. Scroll
through the list of programs and make sure “System Monitor” is checked. Click
‘OK’ and follow the installation instructions.
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— IRQ Latency —
This statistic indicates the maximum number of audio samples
that have elapsed between the time the Dakota hardware asked
for service and the time Windows began to process the request.
Typically it’s less than 5.

Correlating the system’s response time to interrupts with other system
activity will help you determine if there are other installed devices that
prevent Dakota from being serviced efficiently. To calculate the
absolute latency (accurate to within one sample), divide the IRQ
latency by the current sample rate.

— IRQ Misses —
Normally, this should be zero. An IRQ miss means the Dakota driver
wasn’t given enough time to transfer audio between your PC and
the Dakota hardware. This is a severe problem, and indicates that
something in the system is causing gross timing latencies that can’t be
overcome. The result can be brief audio dropouts or pops. Try to
determine whether another device is active when the IRQ misses occur,
and then correct the situation by removing that device or by not using
it while also trying to transfer audio.

— Input Overruns —
This statistic indicates how many errors occurred when Dakota was
ready to transfer newly-recorded information to an application, but the
application hadn’t supplied a buffer in which to write the audio data.
Input overruns are generally caused by an overloaded CPU or
a disk system that can’t keep up with the audio applications.

— Output Underruns —
This statistic indicates the number of times that the driver ran out of
data to send to the digital audio outputs. Generally, it means that the
CPU or disk system couldn’t keep up with the real-time demands of the
application. It’s normal to see a “blip” when playback stops, but an
output underrun in the middle of playback indicates a problem.
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Dakota Specifications
These specifications are subject to revision without notice.

Digital audio inputs 16 channels ADAT optical format (2 TOSLINK optical ports)

2 channels SPDIF format from CD-ROM digital output, or
either TOSLINK optical port, or coaxial input (RCA phono
connector via breakout cable from HD-15 port)

Digital audio outputs 16 channels ADAT optical format (2 TOSLINK optical ports)

2 channels SPDIF format on both TOSLINK optical ports
and on RCA phono connector via breakout cable from
HD-15 port

MIDI I/O 2 MIDI inputs + 2 MIDI outputs
via breakout cable connected to miniDIN-8 port

(can be expanded to 8 MIDI inputs + 8 MIDI outputs +
SMPTE I/O with Sierra MIDI/SMPTE box connected to
Dakota’s miniDIN-8 port)

ADAT sync input DB-9 connector via breakout cable from HD-15 port

SMPTE timecode Any audio input or output can be used for SMPTE
timecode;
Dedicated SMPTE timecode I/O jacks available via Sierra

Sample rates 44.1 and 48 kHz internal,

Varispeed and input tracking from 39–51 kHz,

Real-time resampling to support
8, 11.025, 16, 22.05, and 32 kHz output streams

Audio data 8, 16, 20, 24 bit resolution

Software Windows 95/98 device driver,

Control panel for displaying status and setting options

System requirements 1 PCI slot and 1 IRQ

Internal expansion 40-pin connector for cable to Montana board

Dimensions 6.6" x 4.2" (16.8cm x 10.7cm), PCI short card
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